Backup & Recovery™ 2012 Free

User Manual
Contents

Introduction ........................................................................................................................................ 6
What’s New in Backup & Recovery 2012 Free ................................................................................... 6
Product Components ..................................................................................................................... 6
Features Overview .......................................................................................................................... 6

Key Features ..................................................................................................................................... 6
User Friendly Fault Minimizing Interface ........................................................................................ 6
Backup Facilities ............................................................................................................................ 6
Restore Facilities ............................................................................................................................. 7
Partition/Hard Disk Management Facilities .................................................................................. 7
Automatization Facilities ................................................................................................................ 7
Auxiliary Facilities .......................................................................................................................... 7

Supported Technologies .................................................................................................................. 8
Supported File Systems ................................................................................................................... 8
Supported Media .............................................................................................................................. 9

Getting Started ................................................................................................................................ 9
Contacting Paragon Software GmbH .............................................................................................. 9

System Requirements ...................................................................................................................... 9
Windows based set of utilities ......................................................................................................... 9
Linux/DOS based recovery environment ........................................................................................ 9
Additional requirements ................................................................................................................ 10

Installation ....................................................................................................................................... 10
First Start ......................................................................................................................................... 11
Building Recovery Media ................................................................................................................ 11
Booting from the Linux/DOS Recovery Media .................................................................................. 12
Startup ............................................................................................................................................. 12
Boot menu ....................................................................................................................................... 12

Basic Concepts ................................................................................................................................ 14
System and Data Protection ............................................................................................................. 14
Backup Types .................................................................................................................................. 14
Backup Storage .................................................................................................................................. 15
Paragon Hot Processing & Volume Shadow Copy Service ............................................................... 15
Offline versus Online Data Processing .......................................................................................... 15
Paragon Hot Processing Technology ................................................................. 16
Volume Shadow Copy Service ........................................................................... 16
GPT versus MBR ............................................................................................... 16
64-bit Support .................................................................................................... 17
Drive Partitioning .............................................................................................. 17
Scheduling .......................................................................................................... 18
Windows Components ....................................................................................... 18
Interface Overview .......................................................................................... 18
General Layout .................................................................................................. 18
Main Menu ......................................................................................................... 19
Tool Bar ............................................................................................................. 22
Virtual Operations Bar ..................................................................................... 22
Common Tasks Bar ......................................................................................... 23
Disk Map ........................................................................................................... 24
Explorer Bar ...................................................................................................... 25
Legend Bar ......................................................................................................... 25
Status Bar ......................................................................................................... 26
Settings Overview ............................................................................................ 26
General Options .............................................................................................. 26
Backup Image Options ..................................................................................... 27
Partitioning Options ........................................................................................ 28
General Copy and Backup Options ................................................................. 28
CD/DVD Recording Options ........................................................................... 29
Hot Processing Options .................................................................................. 29
Virtual Mode Options ..................................................................................... 30
File System Conversion Options ...................................................................... 31
Copy/Backup Exclude Options ........................................................................ 31
Log Files Options ............................................................................................. 32
Getting Information on Disks and Backup Images ......................................... 33
Viewing Disk Properties .................................................................................. 33
Viewing Image Properties ............................................................................... 34
Data Backup and Rescue .................................................................................. 39
Creating Backup Images .................................................................................. 39
Restoring System and Data ............................................................................. 42
Introduction
Paragon Backup & Recovery™ 2012 Free is a complex disaster recovery and system migration solution.
By implementing in this product modern technologies the company has offered rock-solid facilities to build a reliable shield against any disaster.
In this manual you will find the answers to many of the technical questions, which might arise while using the program.

⚠️ Our company is constantly releasing new versions and updates to its software, that’s why images shown in this manual may be different from what you see on your screen.

What’s New in Backup & Recovery 2012 Free
- Support of Windows 8.

Product Components
In order to cope with different tasks, the product contains several components:
- **Windows based set of utilities** is the crucial part of the product. With the help of an easy to use launcher you may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and cloning, etc.
- **Linux/DOS based recovery environment** is a multi-platform bootable media that enables to run utilities under Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. Both platforms have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB devices. It enables to burn CD/DVD disks. However there can be some difficulties with detecting new hardware. DOS in its turn has no problems of that kind but is limited in features. The Linux/DOS recovery environment requires no installation and can be of great help when the system fails to boot. Besides it offers a Windows XP like environment.

Features Overview
This chapter dwells upon key benefits and technical highlights of the product.

Key Features
Let us list some of the key features:

User Friendly Fault Minimizing Interface
- **Graphical representation of the data** to gain a better understanding.
- **A handy launcher** to easily find and run the required tasks.
- **Comprehensive wizards** to simplify even the most complex operations.
- **A context sensitive hint system** for all functions of the program.
- **Previewing the resulting layout of hard disks before actually executing operations** (so-called virtual operations).

Backup Facilities
• **Archive Database** to help the user easily manage backup images (get properties, add, delete, mount, etc.).

This feature is only available for the Windows installation of the program.

• **Support of all present day techniques to store backup images:**
  - *Backup to local mounted/unmounted (without drive letter assigned) partitions;*
  - *Backup to an external mounted storage* to provide for a higher level of data protection and system independence;
  - *Backup to a special secured place on the hard disk called the Backup Capsule* that has an independent system layout (e.g. a separate partition) and will stay operable should the active file system be damaged. To avoid an accidental removing or unauthorized access of the backup data, this partition is hidden and thus cannot be mounted in the operating system;
  - *Backup to external media (CD/DVD)* to guarantee a high level of data protection as long as the backup media is kept secure;
  - *Backup to a network drive* to stand a better chance of success in case of a hard disk failure.

• **Sector backup** to save not only all on-disk information but also the system service structures. It is ideal for making a backup image of an entire hard disk or system partitions to guarantee the operating system’s working capability.

• **Differential backup** to a sector image to only archive changes since the last full sector-based image, thus considerably saving the backup storage space. To restore this kind of backup you will require a full image and one of its differentials.

**Restore Facilities**

• **Restore an entire disk, separate partitions** or **only files you need** from the previously created backup image.

• **Restore with Shrink** to restore a backup image to a free block of smaller size taking into account only the amount of actual data of the image.

**Partition/Hard Disk Management Facilities**

• **Basic functions for initializing, partitioning and formatting hard disks** (create, format, delete). Instead of the standard Windows disk tools, the program supports all popular file systems.

• **Mount a partition** (assign a drive letter) of any file system type to make it available for your operating system.

• **Modify file system parameters** (make active/inactive, hide/unhide, volume label, etc.).

**Automatization Facilities**

• **Task scheduling** to automate routine operations. It can be particularly effective when you have to repeat a sequence of actions on a regular basis.

Scheduling is only available for the Windows installation of the program.

**Auxiliary Facilities**
• **File Transfer Wizard** to make such operations as transferring of files/directories or burning of them to CD/DVD as easy and convenient as possible. Providing access to Paragon backups as regular folders, it may also help to replace corrupted data from a previously created image in case of an operating system failure.

• **Recovery Media Builder** to create a bootable recovery media based on Linux/DOS on a CD, DVD disc, or flash memory, which can later be used to boot and recover your computer in case of an operating system failure. Moreover, with its help you can save data from partitions of your hard disk directly to compact discs or burn ISO-images. The utility supports various formats of laser discs: CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R, DVD+R double layer, Blu-ray and can handle multi-session burning.

• **Network Configuration Wizard** to establish a network connection under Linux either to save a backup of a partition/hard disk or just several files on a network computer or retrieve a previously made backup from a network computer for recovery purposes.

**Supported Technologies**

Along with using innovative technologies from outside, Paragon has developed a number of its own original technologies that make its products unique and attractive for customers:

• **Paragon Hot Backup™** technology to back up locked partitions and hard disks under Windows NT+ family operating systems providing both high operating efficiency as well as low hardware requirements.

• **Paragon Power Shield™** technology to provide data consistency in case of a hardware malfunction, power outages or an operating system failure.

• **Paragon UFS™** technology to browse partitions of any file system including hidden and unmounted, modify and copy files and folders, etc.

• **Paragon Restore with Shrink™** technology to restore a backup image to a free block of smaller size taking into account only the amount of actual data of the image.

• **Paragon Smart Partition™** technology to securely perform hard disk partitioning operations of any complexity.

• **Paragon BTE™** technology to set tasks for execution in the Windows blue screen mode, thus saving from the need to use a bootable media when modifying system partitions.

• **Microsoft Volume Shadow Copy Service (VSS)** to provide the copy/backup infrastructure for the Microsoft Windows XP/Vista/7 operating systems. It offers a reliable mechanism to create consistent point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

• **GUID Partition Table** (GPT). It is the next generation of a hard disk partitioning scheme developed to lift restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Mac OS X and Linux.

**Supported File Systems**

Paragon Backup & Recovery 2012 Free provides support for the major file systems presented on the market today:

• Full read/write access to FAT16/FAT32 partitions.

• Full read/write access to NTFS under Windows 95/98/ME, Linux and PTS DOS. Compressed NTFS files are also supported.

• Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions under all versions of Windows, DOS 5.0 and later.

• Limited read/write access to Apple HFS+ partitions.
Supported Media

- Support of both MBR and GPT hard disks (up to 1.5 TB tested)
- IDE, SCSI and SATA hard disks
- FireWire (i.e. IEEE1394), USB 1.0, USB 2.0 hard disks
- PC card storage devices (MBR and GPT flash memory, etc.)

Getting Started

In this chapter you will find all the information necessary to get the product ready to use.

Contacting Paragon Software GmbH

If you have any questions about the company products, please do not hesitate to contact Paragon Software GmbH.

<table>
<thead>
<tr>
<th>Service</th>
<th>Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visit Paragon GmbH web site</td>
<td>[<a href="http://www.paragon-software.com">www.paragon-software.com</a>]</td>
</tr>
<tr>
<td>Registration &amp; updates web-service</td>
<td>[<a href="http://www.paragon-software.com/support">www.paragon-software.com/support</a>]</td>
</tr>
<tr>
<td>Knowledge Base &amp; Technical Support</td>
<td>[kb.paragon-software.com]</td>
</tr>
<tr>
<td>Pre-sale information</td>
<td>[<a href="mailto:sales@paragon-software.com">sales@paragon-software.com</a>]</td>
</tr>
</tbody>
</table>

System Requirements

Windows based set of utilities

To use the Windows utilities, you should install them first. But before that, please make sure your computer meets the following minimum system requirements:

- Operating systems: Windows 2000/XP/Vista/7/8 and Vista/7/8 64-bit
- Internet Explorer 5.0 or higher
- Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
- 128 MB of RAM (256+ recommended)
- Hard disk drive with 100 MB of available space
- SVGA video adapter and monitor
- Mouse

Linux/DOS based recovery environment

To use the Linux/DOS recovery environment on your computer (it doesn’t matter what operating system is installed), please make sure that it meets the following minimum system requirements:
- IBM AT compatible computer with i486 or higher CPU
- 256 MB of RAM
- SVGA-compatible monitor
- Mouse (recommended)

**Additional requirements**

There may be additional requirements if you want to use advanced features:

- Network card to send/retrieve data to/from a network computer
- Recordable CD/DVD drive to burn data to compact discs
- External USB hard drive to store backup data.

**Installation**

As we have already mentioned only Windows components of the product require installation. So to install Paragon Backup & Recovery 2012 Free under Windows, please do the following:

1. **Run Setup Application.** Click on the *.MSI file. This application will guide you through the process of the program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user interface and set of installation steps.

   **In case there is some previous version of the program installed on the computer, the program will offer the user to uninstall it first.**

2. **Starting Setup.** The Welcome page informs that the application is being installed. Click the Next button to continue.

3. **Confirm License Agreement.** The License Agreement page displays the Paragon License Agreement. Read the agreement and then select the appropriate option to accept. If you do not agree with any conditions stated there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also be printed out.

4. **Provide Registration Information.** On the Registration page you are to provide your product key and serial number.

5. **Select an Installation Folder.** The Destination Folder page allows you to choose a folder where the program will be installed. By default, the installation folder will be created as:

   \C:\Program Files\Paragon Software\Backup and Recovery 2012 Free. To select another folder, click the Change... button.

   After you have selected the required folder, click the Next button to continue.

   **Do not install the program on network drives. Do not use Terminal Server sessions to install and run the program. In both cases, the program functionality will be limited.**

6. **Confirm Installation.** On the Ready to Install the Program page click the Install button to start the installation or the Back button to return to any of the previous pages and modify the installation settings.

7. **Copying Files.** The Copying Files page shows the overall progress of the installation. Click the Cancel button to abort the setup.
8. **Finishing the Installation.** The Final page reports the end of the setup process. Click the Finish button to complete the wizard.

**First Start**

To start Paragon Backup & Recovery 2012 Free under Windows, please click the Windows Start button and then select `Programs > Paragon Backup and Recovery™ 2012 Free > Paragon Backup and Recovery™`.

The program provides wide opportunities in the field of hard disk structure modification, so just to be on the safe side, please make a backup of your data before carrying out any operation.

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page.

To know more on how to handle the product’s interface and accomplish typical operations, please consult the [Windows Components](#) chapter.

**Building Recovery Media**

Recovery Media Builder can help you accomplish the following operations:
• Prepare the Linux/DOS recovery environment (included in the installation package) on external media (CD, DVD, or flash memory) to boot and run utilities under Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes (strongly recommended);
• Prepare a custom Linux/DOS recovery environment by adding any data you like to the standard image;
• Prepare a bootable recovery environment from any ISO image;
• Create from the master CD the Linux/DOS recovery environment on a CD/DVD disc, or flash memory.

Booting from the Linux/DOS Recovery Media

The Linux/DOS recovery environment can be used to boot your computer into Linux or PTS DOS to get access to your hard disk for maintenance or recovery purposes. It also has the PTS DOS safe mode, which may help in a number of non-standard situations such as interfering hardware settings or serious problems on the hardware level. In this case, only basic files and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded.

Startup

To start working with the Linux/DOS recovery environment, please take the following steps:

1. Start up the computer from our Linux/DOS recovery media.

   **Recovery Media Builder** can help you prepare the Linux/DOS recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. Launch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu.

   **By default the Normal Mode will be automatically initiated after a 10 second idle period.**

3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right choice.

4. Consult the help system by pressing **ALT+F1** to know more on the subject.

Boot menu

The Boot menu contains the following commands:

- **Normal Mode.** Boot into the Linux normal mode. This mode uses the full set of drivers (recommended);
- **Safe Mode.** Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal mode if it fails to work properly;
• **Low-Graphics Safe Mode.** Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu;

• **Floppy Disk.** Reboot the computer from a system floppy disk;

• **Hard Disk 0.** Boot from the primary hard disk;

• **Find OS(s) on your hard disks.** The program will scan hard disks of your computer to find any bootable operating system.

To move within the menu, please use the arrow keys of the computer keyboard.

**While working with the recovery environment you might experience some inconvenience caused by possible video artifacts. It is just a result of changing video modes and in no way will affect the program functionality. If this is the case, please wait a bit and everything will be OK.**

---

**Normal Mode**

When the Normal mode is selected, the Linux launch menu appears:

- **Backup and Recovery** (enables to copy and back up separate partitions or entire hard disks, carry out basic partitioning operations, etc.);

- **Simple Restore Wizard** (allows restoring hard disks and partitions);

- **File Transfer Wizard** (allows coping files/folders to another disk or a partition as well as recording them to CD/DVD);

- **Network Configurator** (enables to establish a network connection under Linux);

If you are going to use network resources, first launch the Network Configuration Wizard to establish a network connection.

- **Log Saver** (helps to collect and send the necessary log files to the Technical Support);

- **Eject CD/DVD**;

- **Command Line** (allows experienced users to execute any operation);
- Reboot the computer;
- Power off the computer.

To move within the menu, please use the arrow keys of the computer keyboard.

**Safe Mode**

When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the Normal mode except the **Network Configurator** and **Log Saver** commands. Besides due to certain limitations of the PTS DOS environment, there is no possibility to burn CD/DVD discs.

**Low Graphics Safe Mode**

When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality and looks similar to the Safe mode but graphically simpler.

---

**Basic Concepts**

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general notion of the operation performance and makes it easier for the user to operate the program.

**System and Data Protection**

The data protection issue is a growing cause of worrying for more and more people today. Indeed, it is hardly to find a person who will be particularly happy when all precious information on the hard disk is irreversible lost as a result of its malfunction. So how this tragedy can be prevented?

**Backup Types**

At the present moment the market is offering various types of backup imaging to meet the needs of any user.

**Full and Differential Sector Backups**

A full sector-based backup image includes all contents of a partition or a hard disk at the moment of its creation. If you roll back your system to the initial state on a regular basis, that’s exactly what you’re looking for. But if you want to have multiple backup archives of the same partition reflecting certain time stamps, unchanged data will inevitable be duplicated in all archives and take additional space on backup media. To tackle this issue there has been developed a supplementary technique called Differential Sector Backup.

A differential archive only contains data changed since the time of creating a full archive, which forms a base (or a parental image) in this case, thus considerably saving your system resources. It is realized by the exact bit-wise comparison of the previous partition’s data (saved in the parental image) with the current data (that is actually the
partition itself). To restore this kind of backup you will require a full image and one of its differentials, what is very convenient.

**Differential Base to a Sector Backup**

<table>
<thead>
<tr>
<th>Sunday</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Saturday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Sector Backup</td>
<td>Diff #1</td>
<td>Diff #2</td>
<td>Diff n</td>
</tr>
</tbody>
</table>

This function is only available for single primary and logical partitions.

### Backup Storage

Our program supports all present day techniques of storing backup images. Let’s take a closer look at them all to understand what kind of storage is able to provide better security:

- You can place a backup image to a local mounted or unmounted (without drive letter assigned) partition. Despite the fact that it is the most convenient way, try not to use it. You can delete your backup just by accident or lose it as a result of a hardware malfunction, or a virus attack;

- You can place a backup image to an external mounted storage to provide for a higher level of data protection and system independence;

- You can place a backup image to a special secured place on the hard disk called the Backup Capsule that has an independent system layout (e.g. a separate partition) and will stay operable should the active file system be damaged. To avoid an accidental removing or unauthorized access of the backup data, this partition is hidden and thus cannot be mounted in the operating system. However it won’t help you in case of a hardware malfunction;

- You can place a backup image to external media (CD/DVD) to guarantee a high level of data protection as long as the backup media is kept secure;

- You can place a backup image to a network drive to stand a better chance of success in case of a hard disk failure. Moreover, by storing it on a special-purpose server you may be pretty sure nothing will happen to it.

### Paragon Hot Processing & Volume Shadow Copy Service

#### Offline versus Online Data Processing

In the course of time there have been developed various methods of data processing. Despite different work concept, all of them can be divided into two principal groups: offline (cold) and online (hot) data processing techniques.

As the name infers, offline data processing can only be accomplished when the data is in consistent state (the operating system and all the applications are completely shut down). Actually it is the most preferable way of image creation or
data cloning, since software can obtain an exclusive right to process data that guarantees high level of operating efficiency. However, the offline data processing is absolutely out of question when dealing with 24/7 production environments.

In contrast, online data processing enables to create a consistent snapshot even as the data is currently modified. It is particularly useful for systems with high availability requirements, but it won’t be accomplished until all active transactions are complete. The point is to provide a coherent state of all open files and databases involved in a process, taking into account that applications may still keep writing to disks. As a result an online data processing cannot boast high operating speed.

Our program supports both offline and online methods of data processing. As far as online method is concerned it offers its own hot processing algorithm together with the possibility to use snapshot technologies provided by the Microsoft VSS framework.

Paragon Hot Processing Technology

Paragon Hot Processing is an online copy/backup technology for Windows NT+ family operating systems. Developed back in 2001, nowadays it is integrated with all copy/backup solutions offered by the company.

Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During an online copy/backup, the program uses the kernel mode driver HOTCORE.SYS to intercept and control disk write activity of applications and the operating system. The hotcore driver as an integral part of the program is installed during the setup procedure (that’s why the system reboot is required to complete the setup procedure). For the most part the driver is in the idle mode until it is activated with the program. While in this mode it bypasses any calls having no effect on the overall system performance, but a few kilobytes of the system memory.

Paragon Hot Processing technology offers copy/backup of locked partitions and hard disks under Windows NT+ family operating systems providing both high operating efficiency as well as low hardware requirements.

It is not recommended to use Paragon Hot Processing with active SQL Server, Exchange or Oracle databases since the backup image contents may be corrupted.

Volume Shadow Copy Service

Microsoft Volume Shadow Copy Service (VSS) is designed to provide the copy/backup infrastructure for the Microsoft Windows XP/Vista/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

Initiated by a VSS aware copy/backup utility, VSS creates snapshots for the selected volumes and represents them as virtual read-only devices, called volume shadow copies. Once the shadow copies are created, the copy/backup utility starts processing the data while applications keep writing to original volumes.

Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a synchronous snapshot of multiple volumes. This very feature can be particularly beneficial when backing up active SQL Server 2003, Exchange 2003 or Oracle databases located on multiple volumes the way it is recommended by Microsoft to improve the level of database performance and reliability, thus providing 100-percent data consistency.

To use VSS it is necessary to have a mounted 300 MB+ NTFS partition.

GPT versus MBR
GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC BIOS, it offers a number of crucial benefits:

- Up to 128 primary partitions for the Windows implementation (only 4 in MBR);
- The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR);
- More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table;
- A well defined and fully self-identifying partition format (data critical to the platform operation is located in partitions, but not in un-partitioned or hidden sectors as this is the case with MBR).

64-bit Support

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user. However that is not the case when dealing with servers processing large amounts of data with complex calculations of very large numbers. That is where 64-bit architecture comes into play.

It can boast improved scalability for business applications that enables to support more customer databases and more simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor. With these resources, even a very large database can be cached in memory.

Although many business applications run without problems on 32-bit systems, others have grown so complex that they use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the database.

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing.

Drive Partitioning

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is carved up and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled the entire hard disk and contained an OS. The situation has changed however, thanks to new cost-effective high capacity hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up CD images, etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective data organization and speed.

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to have its work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard drives, but there is an easy solution – drive partitioning. Partitioning lets you divide a single physical drive into a number of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing video and another 50 GB for your favorite music collections to provide transparent data storage.

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files defragmentation or consistency check will not be that annoying and time-consuming any more.
By detaching the OS from the rest of the data you can tackle one more crucial issue – in case of a system malfunction, you can get the system back on track in minutes by recovering it from a backup image located on the other partition of the hard drive.

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the boundaries of each OS.

**Scheduling**

The automation of operations is particularly effective when you have to repeat a sequence of actions on a regular basis. For example, developing a specific project on a day-to-day basis and having to make a backup every evening so as not to lose the valuable data, you will really appreciate, when this kind of routine operations will be carried out automatically without your participation.

Another aspect of any automation process is that it allows an optimization of your computer’s work-load. This is especially important when operations require a considerable amount of computer resources – processor time, memory and more. A number of tasks, which can decrease the performance, can be run during the night or whenever the computer has the least work-load to perform.

The program has a special tool for scheduling. You can set out a timetable for any operation and it will start at a specified time without interrupting your current activity.

**Windows Components**

In the given section you can find all the information necessary to successfully work with the Windows version of the product.

**Interface Overview**

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program can be tackled by reading this very chapter.

**General Layout**

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration.

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and functionality:
A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout.

**Main Menu**

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below:

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools</td>
<td></td>
</tr>
<tr>
<td>View Logs...</td>
<td>View logs on the carried out operations</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Recovery Media Builder</strong></td>
<td>Restore the system even when the current operating system cannot boot anymore</td>
</tr>
<tr>
<td><strong>Check Recovery Disks</strong></td>
<td>Verify the recovery media for integrity and ability to boot from</td>
</tr>
<tr>
<td><strong>File Transfer Wizard</strong></td>
<td>Transfer data from any media</td>
</tr>
<tr>
<td><strong>Settings</strong></td>
<td>Edit the general settings of the program</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Exit the program</td>
</tr>
<tr>
<td><strong>Changes</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Save to Scheduler</strong></td>
<td>Schedule pending operations</td>
</tr>
<tr>
<td><strong>Undo ‘the last virtual operation’</strong></td>
<td>Cancel the last virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td><strong>Redo ‘the last virtual operation’</strong></td>
<td>Cancel the last undo virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td><strong>View Changes</strong></td>
<td>Display the List of Pending Operations</td>
</tr>
<tr>
<td><strong>Apply Changes</strong></td>
<td>Launch the real execution of virtual operations</td>
</tr>
<tr>
<td><strong>Discard All Changes</strong></td>
<td>Cancel all virtual operations on the List of Pending Operations</td>
</tr>
<tr>
<td><strong>Reload Disk Info</strong></td>
<td>Refresh the current information about disks</td>
</tr>
<tr>
<td><strong>Wizards</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Backup Disk or Partition</strong></td>
<td>Create a sector-based archive of an entire hard disk or separate partitions</td>
</tr>
<tr>
<td><strong>Differential Backup</strong></td>
<td>Create a differential to a partition backup</td>
</tr>
<tr>
<td><strong>Restore</strong></td>
<td>Restore an entire hard disk, separate partitions, or files from the backup image</td>
</tr>
<tr>
<td><strong>Manage Backup Capsule</strong></td>
<td>Create and manage the backup capsule</td>
</tr>
<tr>
<td><strong>Check Archive Integrity</strong></td>
<td>Perform integrity check for the required backup image</td>
</tr>
<tr>
<td><strong>Hard Disk</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Update MBR</strong></td>
<td>Update MBR (Master Boot Record) of the selected hard disk</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Get in-depth information on the properties of selected hard disk</td>
</tr>
<tr>
<td><strong>Partition</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Create Partition</strong></td>
<td>Create a partition</td>
</tr>
<tr>
<td><strong>Format Partition</strong></td>
<td>Format a partition</td>
</tr>
<tr>
<td><strong>Delete Partition</strong></td>
<td>Delete a partition</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Assign Drive Letter...</strong></td>
<td>Assign drive letter to the selected partition</td>
</tr>
<tr>
<td><strong>Remove Drive Letter...</strong></td>
<td>Remove drive letter for the selected partition</td>
</tr>
<tr>
<td><strong>Hide Partition...</strong></td>
<td>Make the selected partition unavailable for the operating system</td>
</tr>
<tr>
<td><strong>Unhide Partition...</strong></td>
<td>Make the selected partition available for the operating system</td>
</tr>
<tr>
<td><strong>Mark Partition as Active</strong></td>
<td>Make the selected partition bootable by default</td>
</tr>
<tr>
<td><strong>Mark Partition as Inactive</strong></td>
<td>Make the selected partition non-bootable by default</td>
</tr>
<tr>
<td><strong>Change Volume Label...</strong></td>
<td>Change volume label of the selected partition</td>
</tr>
<tr>
<td><strong>Test Surface...</strong></td>
<td>Test surface of the selected partition/block of free space</td>
</tr>
<tr>
<td><strong>Check File System Integrity...</strong></td>
<td>Check the selected partition for possible file system errors</td>
</tr>
<tr>
<td><strong>Properties...</strong></td>
<td>Get in-depth information on the properties of selected partition</td>
</tr>
<tr>
<td><strong>Archives</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Add an Archive to the Database...</strong></td>
<td>Add an existing archive to the archive database</td>
</tr>
<tr>
<td><strong>Delete the Archive from the Database...</strong></td>
<td>Delete archive files from the archive database</td>
</tr>
<tr>
<td><strong>Restore from the Selected Archive...</strong></td>
<td>Restore an image of hard disk or partition</td>
</tr>
<tr>
<td><strong>Restore File From Archive</strong></td>
<td>Restore separate files from the archive</td>
</tr>
<tr>
<td><strong>Differential Backup...</strong></td>
<td>Create a differential to a partition backup</td>
</tr>
<tr>
<td><strong>Check Archive Integrity...</strong></td>
<td>Perform integrity check for the required backup image</td>
</tr>
<tr>
<td><strong>Mount the Selected Archive...</strong></td>
<td>Assign a drive letter to a partition backup image</td>
</tr>
<tr>
<td><strong>Unmount the Selected Archive...</strong></td>
<td>Remove a drive letter to a partition backup image</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
<td>Manage the Tool Bar representation: show / hide standard and navigation buttons, text labels and large icons</td>
</tr>
<tr>
<td><strong>Status Bar</strong></td>
<td>Display the Status Bar</td>
</tr>
<tr>
<td><strong>Common Tasks Bar</strong></td>
<td>Display the Common Tasks Bar</td>
</tr>
<tr>
<td><strong>Disk Map Legend</strong></td>
<td>Display the Disk Map legend</td>
</tr>
</tbody>
</table>
Help

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Open the Help system (you can also do it by pressing F1)</td>
</tr>
<tr>
<td>About</td>
<td>Open the dialog with information about the program</td>
</tr>
</tbody>
</table>

The Main Menu contents available at the moment may vary depending on the selected object.

Tool Bar

The Toolbar provides fast access to the most frequently used operations:

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>![image]</td>
<td>Create an image of a hard disk or partition</td>
</tr>
<tr>
<td>![image]</td>
<td>Restore an image of hard disk, partition, or files</td>
</tr>
<tr>
<td>![image]</td>
<td>Open the Help system</td>
</tr>
</tbody>
</table>

Virtual Operations Bar

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations:

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>![image]</td>
<td>Cancel the last virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td>![image]</td>
<td>Cancel the last undo virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td>![image]</td>
<td>Display the List of Pending Operations</td>
</tr>
<tr>
<td>![image]</td>
<td>Launch the real execution of virtual operations</td>
</tr>
<tr>
<td>![image]</td>
<td>Cancel all virtual operations on the List of Pending Operations</td>
</tr>
</tbody>
</table>

Virtual mode is an effective way of protection from any troubles, since no operations will be executed until clicking the Apply button for confirmation, thus giving a second chance to weigh all pros and cons of this or that particular operation. The program politely reminds...
the user that there are unsaved changes by showing the following window:

---

**Common Tasks Bar**

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program’s wizards.

The bar contains several tabs named **Basic Backup/Restore Tasks**, **Advanced Backup Tasks**, **Tools** and **News and Documentation**. Each of these contains a separate button bar which can be folded by clicking it.

<table>
<thead>
<tr>
<th>Basic Backup/Restore Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Back Up" /></td>
</tr>
<tr>
<td>Starting the Backup Wizard to create an image of a hard disk or separate partition.</td>
</tr>
<tr>
<td><img src="image" alt="Restore" /></td>
</tr>
<tr>
<td>Starting the Restore Wizard to restore a hard disk, separate partition, or files from the backup image.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Advanced Backup Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Differential Partition Backup" /></td>
</tr>
<tr>
<td>Starting the Differential Backup Wizard to create a differential to a partition backup.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Manage Backup Capsule" /></td>
</tr>
<tr>
<td>Starting the Manage Backup Capsule Wizard to create, resize or delete the backup capsule.</td>
</tr>
<tr>
<td><img src="image" alt="Recovery Media Builder" /></td>
</tr>
<tr>
<td>Starting the Recovery Media Wizard to create a Linux/DOS bootable media which can be used to get access to your hard disk for maintenance or recovery purposes.</td>
</tr>
<tr>
<td><img src="image" alt="Check Recovery Discs" /></td>
</tr>
<tr>
<td>Starting the Check Recovery Disk Wizard to verify recovery media for integrity and ability to boot from.</td>
</tr>
<tr>
<td><img src="image" alt="Check Archive Integrity" /></td>
</tr>
<tr>
<td>Starting the Check Archive Integrity Wizard to verify backup archives for consistency.</td>
</tr>
<tr>
<td><img src="image" alt="Transfer Files" /></td>
</tr>
<tr>
<td>Starting the File Transfer Wizard to transfer data from any media. Besides it provides access to Paragon backups as regular folders to browse through their contents or copy required files.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>News and Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Backup &amp; Recovery™ Help" /></td>
</tr>
<tr>
<td>Launching the help system (you can also do it by pressing F1).</td>
</tr>
</tbody>
</table>
Disk Map

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map Location).

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the file system of the appropriate partition.

![Disk Map Image]

Large-sized bars display the following information about physical disks:

- Manufacturer,
- Model.

Small-sized bars display the following information about logical disks:

- Serial number,
- Drive letter,
- Total size,
- File system.

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program offers to choose from several types of the disk layout scaling. It’s done especially to increase the program usability. For instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk layout is critical for you, the linear type is exactly what you need.

Nevertheless there’s a compromise solution – linear scaling with the minimal limit to small partitions. So if a partition is too small it will remain readable.

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type.

![Scaling Options Image]

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will automatically display detailed information on it.
The drag-and-drop functionality is not available when the logarithmic type of the disk layout is selected.

Explorer Bar
The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays reference information including:

- The help system;
- General information on the product including its name, version and a list of helpful links;
- Detailed information about disks selected on the Disk Map;
- List of scheduled operations;
- List of archives.

According to these categories the Explorer Bar has several tabs:

- **Disk View**.
- **Scheduled Tasks**, which gives the user the possibility of browsing and editing scheduled operations and the program scripts.
- **Archives**, which enables to manage the Archive Database.
- **Help**, which contains the program help and general information on the product.

You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the company's website to look through important technical notes or download the latest updates without having to close the program.

The program help is also HTML-oriented. You can read it and follow external links from to get additional information.

To easily navigate through browsed pages, the program provides the following functionality:

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Return to previously browsed page" /></td>
<td>Return to the previously browsed page</td>
</tr>
<tr>
<td><img src="image" alt="Open the next browsed page" /></td>
<td>Open the next browsed page</td>
</tr>
<tr>
<td><img src="image" alt="Stop loading current page" /></td>
<td>Stop loading the current page</td>
</tr>
<tr>
<td><img src="image" alt="Refresh contents current page" /></td>
<td>Refresh the contents of the current page</td>
</tr>
</tbody>
</table>

Legend Bar
The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the Explorer Bar.

The program distinguishes between the following types of known file systems:
- FAT16/32,
- NTFS,
- Linux Ext2/3/4,
- Linux ReiserFS,
- Apple HFS.

**Status Bar**

This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to. The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar.

**Settings Overview**

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections, which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By selecting a section from the list, you can open a set of options.

---

To get a detailed description to any setting, control, or field of the program just click the hint button and then the object you need.

---

**General Options**

This section contains a set of general options that will be taken into account during any operation carried out with the program:

- **Partition Alignment mode.** There are three options you can choose from:
  - **Legacy.** DOS and Windows OSes before Vista required that partitions had to be aligned to the “disk cylinder” or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came into scene. When partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters, thus resulting in a double read-write operation.
  - **Vista.** Since Windows Vista, operating systems do not use the archaic CHS (cylinder/head/sector) addressing scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the whole disk drive. It is optimal for both, 512B and new 4K disk drivers.
- **Inheritance.** Select the option to disable automatic alignment of partitions.

- **Check FS integrity policy.** Accomplishment of any data-sensitive operation (resize, move, merge, redistribute, change cluster size, etc.) is potential with data loss. To minimize this risk, it’s recommended to check integrity of your file system before this type of operations, despite the fact that it’s quite time consuming. We offer you several options to let you choose, which is best for you:
  - **Always.** Maximum protection, but minimal performance. The file system integrity will be checked each time it’s necessary to guarantee the maximum protection for the on-disk data.
  - **Once.** Standard protection with acceptable performance. The file system integrity will be checked for each volume only once just before accomplishing data-sensitive operations.
  - **Never.** No protection, but maximum performance. If you’re not 100% sure your disk is rock solid, please do not use this option.

- **Data Loss Protection mode.** To guarantee safety for your information when a data-sensitive operation has been abruptly interrupted as a result of a computer reset, or a power outage, there are several techniques, that correspond to the options below:
  - **Do not protect.** No protection, but maximum performance. If you’re not 100% sure you’re completely safe from a power outage, or an accidental reset of your computer, please do not use this option.
  - **Reset.** Standard protection with acceptable performance. Maintaining a special journal, our program enables to automatically complete a data-sensitive operation interrupted by an accidental reset of your computer from our bootable recovery media, thus reviving the corrupted partition.
  - **Power loss.** Maximum protection, but minimal performance. Besides journaling, our program will also disable cache of your disk when accomplishing data-sensitive operations to avoid data loss even in case of a power outage.

**Backup Image Options**

This section contains a set of options that will be taken into account during backup/restore operations:

- **Control archive integrity.** Mark the checkbox to guarantee that all backup images created with the program are 100 percent flawless. If you decided not to control the archive integrity, the backup operation would take about 3-5% less time.
- **Set image file names automatically.** Mark the checkbox to make the program automatically set a file name for every volume of a complex backup image. Otherwise you will need to do it manually during the backup operation.

- **Compression level.** From the pull-down list you can select the desired compression level for backup images that will be used by default.

- **Enable image splitting.** Mark the checkbox to automatically split every backup image to volumes of a particular size.

  ![](WarningIcon.png)

  **Splitting images enables to tackle problems caused by a maximum file size limitation of some file systems.**

- **Maximum split size.** With the spinner control you can specify a maximum size for backup volumes.

### Partitioning Options

This section contains a set of options that will be taken into account during partitioning operations:

- **Request confirmation before partition deletion.** Mark the checkbox to activate an additional security mechanism. Thus when going to delete a partition you will be automatically requested to enter its label.

- **Request confirmation when converting FAT16 to FAT32.** Mark the checkbox to automatically request confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition operation involving an extra upsizing.

### General Copy and Backup Options

This section contains a set of options that will be taken into account during copy and backup operations:
• **Partition raw processing.** Mark the checkbox to copy a partition in the sector-by-sector mode to successfully process unknown file systems. However, it is not recommended to enable this option when working with supported file systems as it takes more time to accomplish the operation.

• **Skip OS auxiliary files.** Mark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus reducing the operation time and the resulted size of the backup image.

• **Skip archive files stored in archive library.** Mark the checkbox to skip backup images registered in the archive database, thus reducing the operation time and the resulted size of the backup image.

---

**By clicking the link at the bottom of the window you can jump to the Copy/Backup Exclude Options.**

---

**CD/DVD Recording Options**

This section contains a set of options that will be taken into account during CD/DVD burn operations:

• **Burn every CD/DVD to the end.** By default, the program does not create ISO 9660 compliant burning sessions, as it processes data on-the-fly and can only estimate the resulted session size. That’s why no third party tool will get access to the recorded data. To tackle the issue, mark the checkbox to make the program create a standard Disk-at-Once session. It may slow down the burning process, as every CD/DVD will be recorded up to the end, no matter how much actual information to contain.

• **Recording speed.** The user may define how fast a CD/DVD will be recorded (minimum, normal and maximum). Besides there is an automatic mode when the program will set the most appropriate speed for every CD/DVD.

• **Bootable ISO image.** That’s the image to be placed together with the backup data. By default, the program offers its own bootable ISO image, which contains a Linux/DOS recovery environment. However, the user is free to use any bootable ISO image.

• **CD/DVD boot capability.** The program enables to choose whether any recorded CD/DVD will be bootable, or only the first one for a session, or without that function at all.

• **Folder where the ISO image is to be placed.** When the user decides not to physically burn a CD/DVD, but create an ISO image file, this very folder will be used to contain these images.

---

**Hot Processing Options**
In this section you may configure the hot processing mode:

- **Enable hot processing.** Mark the checkbox to enable the so called hot data processing mode that is specially designed to process data without restarting your operating system.

- **Hot processing technology.** From the pull-down list you can select the required hot processing technology.

- **Always use hot processing.** Select the option to process partitions without making them locked. Thus you will be able to keep working with them as usual.

- **Use hot processing only when partition is locked.** Select the option to use the hot processing only when partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once you start any operation on a partition in this mode, it will automatically be locked by the program, thus you won't be able to keep working with it as usual.

- **Hot processing temporary drive.** Here you can select a disk drive that will be used to store the temporary hot backup data (by default – C:).

- **Attempts to start VSS.** Here you can set how many attempts to start Microsoft VSS the program is to do before automatically rebooting the system and accomplishing the operation in a special boot-up mode.

- **Timeout between attempts (in seconds).** Here you can set a time period between different attempts to start Microsoft VSS.

**Virtual Mode Options**

In this section you may configure the virtual mode:
• **Allow virtual mode.** Mark the checkbox to enable the virtual mode. It is an effective way of protection from any troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all pros and cons of this or that particular operation.

We strongly recommend you to enable this mode.

• **Close progress dialog automatically.** Mark the checkbox to automatically close the progress dialog after accomplishing operations.

**File System Conversion Options**

This section contains a set of options that will be taken into account when converting FAT and NTFS file systems. By default, the program takes locale (regional) settings from the system. Problems might occur however because of different standards for file names and file time stamps (Created, Modified and Last Access Time) of NTFS and FATxx file systems.

To tackle problems of that kind you can manually set:

• **Time zone** to use during the convert operation. NTFS keeps file timestamps in GMT (Greenwich Mean Time) while FAT uses a fixed local date and time. The program takes proper account of these differences and enables to adjust timestamp values.

An incorrectly chosen time zone might lead to inability to launch certain software.

• **Language for file names** to use during the convert operation. NTFS stores file names in Unicode while FAT/FAT32 uses ANSI to save short file names (also called the DOS aliases). The codepage information is required for the correct conversion of non-English file names from Unicode to ANSI and vice versa.

An incorrectly chosen codepage will certainly result in corruption of non-English file names.

• **Request confirmation of settings before NTFS < - > FAT/FAT32 conversion.** Mark the checkbox to automatically display the local settings dialog to check and modify (if necessary) the default parameters before launching the convert file system operation.

**Copy/Backup Exclude Options**
In this section the program enables to specify what data should be automatically ignored during copy and sector-based backup operations. You can filter certain files or folders either by the manual selection or by creating masks, what is more preferable. Thus you will be able to effectively manage contents of your backup images or partition/hard disk copies.

By default, there are no available filters. To create a filter, please click the Add Category… button.

In the opened dialog the program allows the user to define the following parameters:

- **Name.** Give to the filter any name you like, but try to use an informative one;
- **Filter.** Press the Browse button to select files or folders you would like to be excluded or specify a filter mask by using * or ? wildcards;
- **Description.** Add a short description to the filter not to miss it up later.

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox opposite its name you can choose whether to use it or not.

By clicking the link at the bottom of the window you can jump to the General Copy and Backup Options.
In this section you can specify a storage life span for the stubact.log file:

- **Infinite** not to empty the file ever;
- **Minimal** to have the file emptied all the time;
- **Custom** to set a certain storage life span for the file. Please note, once the defined period has been expired, the file will be emptied.

We strongly recommend you not to choose the Minimal option, as in case of having problems with the program, our Support Team won’t be able to study operation logs, thus help you out.

### Getting Information on Disks and Backup Images

The program provides some helpful tools to get information on the properties of disks and peculiarities of existing backup images.

#### Viewing Disk Properties

The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state of the computer’s hard disks.

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information about the disk in a bright, graphical form.

The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may see a table, which contains the following information:

- Type of hard disk (basic or dynamic),

---

Copyright © 1994-2012 Paragon Software GmbH. All rights reserved.
• Total size (in GB),
• Information on geometry of the disk (amount of sectors per track, heads and cylinders).

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard.

When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right will contain the following information:
• Volume label (if available),
• Type of the logical disk,
• File system (represented by the color of the graph and the selected bar),
• Total size, used space and free space (in GB or MB).

Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the disk settings.

**Viewing Image Properties**

General information on backup archives can be obtained either with the help of the **Restore Wizard** or the **Archive Database**:

**Using the Restore Wizard**

There are several ways to launch the Restore Wizard:
• In the Main menu: select **Wizards > Restore...**
• In Common Tasks bar: click the **Restore** item of the Wizards menu
• Select a hard disk/partition and then click the **Restore an image of the entire disk/Restore the logical disk from an image** link on the Explorer Bar page.

At first, the wizard displays the Welcome page – simply click the Next button at the foot of the dialog window.

The next page refers to Browse for Archive. By clicking the **Switch to Archive List View** link, you can see a list of images contained in the Archive Database (if any).
To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description, including:

- Information on a type of the archive contents (whether it is sector-based or file-based),
- Whether the archive is compressed or not,
- Whether the archive is password protected or not,
- The date, when the archive was created.

In addition, there are some special graphical flags to indicate crucial properties:

<table>
<thead>
<tr>
<th>FLAG</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌐</td>
<td>Disk archive</td>
</tr>
<tr>
<td>📀</td>
<td>Partition archive</td>
</tr>
<tr>
<td>📁</td>
<td>File archive</td>
</tr>
<tr>
<td>📄</td>
<td>MBR archive</td>
</tr>
<tr>
<td>⚖</td>
<td>System archive</td>
</tr>
<tr>
<td>🔒</td>
<td>Encrypted archive</td>
</tr>
<tr>
<td>📦</td>
<td>Compressed archive</td>
</tr>
<tr>
<td>🌐</td>
<td>Complex archive</td>
</tr>
</tbody>
</table>
To easily manage images in the Archive Database, the program provides the following functionality:

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Refresh the contents of the database</td>
</tr>
<tr>
<td>📝</td>
<td>Show only existing archives</td>
</tr>
<tr>
<td>🎯</td>
<td>Add the selected archive to the database</td>
</tr>
<tr>
<td>🗑️</td>
<td>Delete the selected archive from the database</td>
</tr>
</tbody>
</table>

Besides you may filter backup archives to decide whether to show only file, partition or hard disk archives. To do that, please select the required filter in the left top corner of the page.

By clicking the **Switch to File View** link, you can find the required image in the browser-like window.
The section below (i.e. Archive File Details) displays a short description of the selected image, including:

- Information on a type of the archive contents (whether it is sector-based or file-based),
- Whether the archive is compressed or not,
- Whether the archive is password protected or not,
- The date, when the archive was created.

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map network drives by clicking the appropriate buttons.

The next page (i.e. What to restore) displays detailed information about the contents of the archive.
If you want to restore the image contents, click the Next button. In order to cancel, click the Cancel button.

**Using the Archive Database**

To open the Archive Database, click the appropriate tab in the Explorer Bar. The database window can be conditionally subdivided into several sections that differ in their purpose and functionality:
1. **Explorer Bar** that displays properties of the selected image.

2. **Files view.**

3. **Archive List** that displays a list of images contained in the Archive Database (if any). Besides the program provides all the necessary functionality to manage backup images in the database (add, delete, mount, refresh, etc.)

---

All panels offer a synchronized layout and are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout.

---

**Data Backup and Rescue**

In this chapter you will find all the information necessary to establish a reliable data protection system.

**Creating Backup Images**

We have already mentioned that the most prevalent way to protect valuable data is to create backup copies (backup images in terms of the program) of it. Depending on a type of information you need to protect and the way this information should be processed, the program offers a number of handy backup wizards and dialogs.

**Wizard Work Algorithm**

To make your job with the program as easy and convenient as possible, all backup wizards share similar work algorithm. So let us just take as an example the Sector Backup Wizard to describe it in detail.
By going through steps of the wizard, you configure all the necessary settings to launch the backup operation. To minimize the possibility of making any mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

**Startup**

To start the Sector Backup Wizard in the Main Menu select Wizards > Back up a Disk or Partition...

**Setup**

The wizard offers the following steps to accomplish the backup operation:

- **The object to back up.** You can back up either an entire disk or separate partitions of the disk (primary, extended or logical). In case of backing up an entire disk, you’ve got the possibility to include into the image such disk elements as the Master Boot Record (MBR) and the first track of the hard disk. This can be very helpful for serious disk recovery procedures.

- **Backup destination.** The wizard allows saving backup archives to local or network drives, to physical partitions (without drive letters assigned), the Backup Capsule or burning them to CD/DVDs. You need to select a destination, taking the estimated archive size and available space on the backup destination into account.

- **Name and location of the resulted image.** Provide a file name for the new image and its exact location. The program automatically offers an easy to understand name containing the date and the time of the archive creation, which can anyway be modified.
The program automatically calculates size of the future archive and informs the user about space available on the selected destination.

- **Archive Comment.** You can add some additional description to the archive that will later help to distinguish it from the others.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to mark the appropriate option on the second page of the wizard. When it is marked, the next page enables to define:

- Whether the archive integrity will be controlled.

Checking archive integrity enables to guarantee that all backup images created with the program are 100 percent flawless. Nevertheless if you decided not to control the archive integrity, the backup operation would take about 3-5% less time.

- Whether image file names will be set automatically in complex archives.
- Compression level for the backup image (including the No compression variant).
- Whether the archive will be split (if yes, you can set the maximum size for the archive files).

Splitting images enables to tackle issues caused by a file size limitation of some file systems.

- Whether the archive will be protected by password.
- Whether the selected disk (or the selected partition) will be copied in the sector-to-sector mode (including unused sectors as well).
- Whether the OS auxiliary files (pagefile.sys, hyberfil.sys) will be included in the backup image.
- Whether backup images stored in the Archive Database will be processed during the backup operation.

Skipping backups of the Archive Database may considerably decrease the resulted image file and time to carry out the operation.

- Recording speed when the user wants to burn the backup image onto CD/DVDs.
- ISO image folder where the archive that is to be recorded on a disc, is placed.
- Whether the operation will be performed without rebooting the system. The program needs to reboot the system in order to have exclusive access to processing data. In a Windows environment this is difficult to achieve because even when all the other applications are closed, the system service programs are still running. However, there is a way to avoid rebooting. The mode of processing the backup operation without rebooting is named Hot Processing. You can also define specific parameters for the Hot Processing mode.
- The data to be automatically excluded from the resulted backup.

By default the program will take into account exclude filters set in the **Settings** dialog.

Copyright© 1994-2012 Paragon Software GmbH. All rights reserved.
Result

After the backup operation is completed you receive an image of the selected disk (or the selected partition). This image is placed into the specified destination, its features defined by the wizard.

Available operation scenarios:

- **Backing up a hard disk or partition to the Backup Capsule**
- **Backing up a hard disk or partition to external media (CD/DVD)**
- **Backing up a hard disk or partition to a network drive**
- **Creating a differential to a full partition backup**

Restoring System and Data

The program includes a convenient and reliable restore wizard. With its help you can restore all types of backup images created with the program. It provides easy to understand instructions to configure and perform all the necessary settings. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

Startup

There are several ways to start the Restore Wizard:

- In the Main Menu: select **Wizards > Restore...**
- On the Common Tasks Bar: click the **Restore** item of the Wizards menu.
- In the Toolbar: click the **Restore Wizard** button.

Setup

The wizard offers the following steps to accomplish the restore operation:

- **A backup image to be restored.** The Browse for Archive page enables to find a backup image you need.

  By clicking the **Switch to Archive List View** link, you can see a list of images contained in the Archive Database (if any).

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.
To know more on the subject, please consult the Viewing Image Properties chapter.

By clicking the Switch to File View link, you can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also display a short description of the selected image.

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map network drives by clicking the appropriate buttons.

To know more on the subject, please consult the Viewing Image Properties chapter.

File Backup Restore

- **Data to restore.** You’ve got the option to restore not only the entire archive, but separate items of it (the so called selective restore functionality) by marking checkboxes next to the data items you need.

- **A place to restore.** From the pull-down list you can choose whether to restore contents of the backup image to its original location or specify some other one.
Besides if you select the Original location option, you can additionally define whether to replace already existing files during the restore operation (good for recovering presumably corrupted files) or leave them intact (good for recovering accidentally deleted files).

**Sector Backup Restore**

- **Data to restore.** When choosing a sector backup, you’ve also got the option to restore not only the entire archive, but separate items of it. Please note however, once you click on the + icon and select particular folders or files to restore, the wizard automatically switches to the file-restore mode, which cannot be used for restoring OS, even if you select all items of a system partition. Your operating system won’t start up after the restore operation is over. To restore OS, please select the entire archive, or only a system partition, just as it’s shown on the screen.

- **A place to restore.** Selecting the destination, please note - all contents on the disk selected for restoring purposes will be deleted during the operation.

If you select separate files or folders to restore, the wizard will continue working as though you’ve got to do with a file backup.

To help you get a clear-cut picture of the operation outcome, the program allows inspecting the resulted disk layout.

**Restoring Partition:**
- Size of the restored volume and free space before and after it on the disk.

- Drive letter assignment after restore. The pull-down list contains vacant drive letters that can be associated with the restored partition.

Restoring Hard Disk:

- Copy data and resize partitions proportionally. If this option is activated, the program proportionally changes the size of partitions keeping their relative order intact. The option can be useful when restoring to a larger hard disk.

- Perform surface test. Define whether the surface test will be accomplished during the operation or not.

All contents on the disk selected for restoring purposes will be deleted during the operation.

Result

The wizard will restore the archived data, and make it available to use in the operating system.

Available operation scenarios:

- Restoring a system partition from external media (CD/DVD)
- Restoring a system partition from a local drive
- Restoring a dual boot Mac from an external USB drive
- Copying of data from the corrupted system disk to another hard disk
- Burning of data from the corrupted system disk to CD/DVD
- Copying of data from a backup to the corrupted system partition
- Restoring separate files and folders from a backup

Partition Management

In this chapter you will find all the information necessary to carry out partitioning operations supported by the program.
Basic Partitioning Operations
Here you can learn how to accomplish basic partitioning operations (create, format, delete).

Creating Partitions
The program provides the ability to create a new partition by using the DOS partitioning scheme. This operation can be accomplished with the Create Partition Dialog.

Restrictions
1. Do not use the Create Partition function in order to undelete the last deleted partition.
2. The program cannot create new partitions on Dynamic Disks. The current version of the program supports only hard disks that use the DOS partitioning scheme (in Windows 2000 and XP these disks are named Basic Disks).
3. According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot be created:
   - Two Extended Partitions on one hard disk
   - Five or more Primary partitions on one hard disk
   - If there is an Extended Partition on the disk, only three Primary partitions are allowed
4. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free space on an existing partition to a new partition.

Startup
In order to start the operation you should take the following steps:
1. Select a block of free space on the Disk Map;
2. Call the Create Partition Dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Partition > Create Partition.
   - Call the popup menu for the block of free space (right click of the mouse button) then select the menu item: Create Partition.

Setup
Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes button to confirm the operation.
• **Define whether the partition will be Primary, Extended or Logical.** You can choose the desired partition type from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free space, both Primary partitions or the Extended Partition can be created.

• **Partition Size.** Define the size (in Mb) of the new partition.

• **Free space before.** Define the position (in Mb) of the new partition relative to the beginning of the block of free space.

• **Free space after.** Define the amount of trailing free space (in Mb) at the end of the new partition.

---

⚠️ **Partition size and position may also be defined by using the drag-and-drop technique. To do that, just carry out the required operation on the Disk Map. The virtual operations are to be available.**

---

• **File system for new partition.** From the pull-down list select a file system the newly created partition will be formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use).

• **Volume label.** Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually used for drive identification.

• **Drive letter assignment.** The pull-down list contains vacant drive letters that can be associated with the newly formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on the chosen file system, the following options become available:
- **Use OS built-in routine.** Mark the option to restrict the available values according to the used OS.
- **Whether the surface test will be performed.** Define the level of the surface check to make the program find bad and unstable sectors and mark them unusable in the file system metadata.
- **The amount of sectors per boot.** This parameter is available exclusively for FAT16 and FAT32 file systems. Set the number of sectors to be reserved for the boot area on the partition with this spinner control.
- **The amount of root entries.** This parameter is available exclusively for FAT16 file system. Set the maximum amount of files/directories to be placed in the Root Directory on the FAT16 partition.
- **The amount of sectors per cluster.** Define the Cluster Size for the formatted partition with this spinner control.

Number of available options depends on the selected file system type.

Result

After the operation is completed you receive a fully functional partition.

**Formatting Partitions**

Any partition should contain some file system to be used for keeping data. The process of installing a file system is commonly known as formatting. A huge variety of file systems have been developed these days.

**Supported File Systems**

The program provides the ability to format partitions of the following file systems:

- FAT12 & FAT16
- FAT32
- NTFS
- Ext2
- Ext3
- Linux Swap v. 2
- Apple HFS

This operation can be accomplished with the Format Partition Dialog.

**Startup**

In order to start the operation you should take the following steps:

1. Select a partition on the Disk Map;
2. Call the Format Partition Dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: **Partition > Format Partition.**
- Call the popup menu for the selected partition (right click of the mouse button) then select the menu item: Format Partition.

Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format button to confirm the operation.

![Image of Format Partition confirmation window]

- **File system.** From the pull-down list select the desired file system type. In fact, the program displays only those file systems that can correctly be placed to the selected partition, taking its capacity into account.

- **Volume label.** Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually used for drive identification.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on the chosen file system, the following options become available:

![Image of advanced settings]

- **Use OS built-in routine.** Mark the option to restrict the available values according to the used OS.

- **Whether the surface test will be performed.** Define the level of the surface check to make the program find bad and unstable sectors and mark them unusable in the file system metadata.

- **The amount of sectors per boot.** This parameter is available exclusively for FAT16 and FAT32 file systems. Set the number of sectors to be reserved for the boot area on the partition with this spinner control.

- **The amount of root entries.** This parameter is available exclusively for FAT16 file system. Set the maximum amount of files/directories to be placed in the Root Directory on the FAT16 partition.

- **The amount of sectors per cluster.** Define the Cluster Size for the formatted partition with this spinner control.

**Number of available options depends on the selected file system type.**

Result

After the operation is completed you receive a fully functional partition formatted to the specified file system.

**Deleting Partitions**
With the Delete Partition Dialog you can delete a partition on a hard disk partitioned with the DOS partitioning scheme. Unlike the majority of other utilities (Windows Disk Manager included), the program can not only remove references to the deleted partition from the Partition Table, thus making it unavailable for the operating system, but also enables to irreversibly destroy its data. This feature will guarantee security of your personal information.

**Startup**

In order to start the operation you should take the following steps:

1. Select a partition on the Disk Map;
2. Call the Delete Partition Dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: **Partition > Delete Partition**.
   - Call the popup menu for the selected partition (right click of the mouse button) then select the menu item: **Delete Partition**.

**Setup**

Initially the program suggests you just to remove references to the selected partition from the Partition Table.

- **Enter the volume label to confirm deleting**. To confirm deletion of the selected partition, enter its Volume Label. The current volume label is displayed above.
- **Do not ask volume label next time**. Mark the option to inhibit confirmation next time you start the dialog.

**Result**

By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the modification of the disk layout. In case you decide to wipe the on-partition data as well, the operation will take much longer, depending on the set wipe parameters.

**Advanced Partitioning Operations**

Here you can learn how to accomplish advanced partitioning operations (undelete).

**Changing Partition Attributes**

This chapter explains how you can change partition attributes (Active flag, Hidden flag, Volume Label, etc.).

**Mark Partition Active/Inactive**

The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an operating system will boot only if its partition is active or bootable.

In order to mark a partition active/inactive you should take the following steps:

1. Select a primary partition on the Disk Map.
2. Call the Mark Partition Active/Inactive Dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Partition > Mark Partition as Active/Inactive.
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: Mark Partition as Active/Inactive.

3. The operation will be performed immediately after confirmation.

⚠️ There can only be one active partition on a hard disk, otherwise your operating system will fail to boot.

---

**Hide/Unhide Partition**

The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mount hidden partitions, thus preventing access to their contents.

In order to hide/unhide a partition you should take the following steps:

1. Select a partition on the Disk Map.
2. Call the Hide/Unhide Partition Dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Partition > Hide/Unhide Partition.
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: Hide/Unhide Partition.
3. The operation will be performed immediately after confirmation.

⚠️ It is strongly recommended not to hide the system partition. Otherwise your operating system will fail to boot.

---

**Set Label of a Partition**

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is detectable by any partitioning tool and is used for notification purposes only.

In order to change a partition label you should take the following steps:

1. Select a partition on the Disk Map.
2. Call the Change Volume Label dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Partition > Modify > Change Volume Label.
   - On the Explorer Bar: click on the current volume label.
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: Change Volume Label.
3. Enter a label for the selected partition.
4. The operation will be performed immediately after confirmation.

**Hard Disk Management**

In this chapter you will find all the information necessary to carry hard disk operations supported by the program (Update MBR, Convert to Basic, Change Primary Slot).

**Updating MBR**

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a malfunction of boot management software.

In order to update MBR of a hard disk you should take the following steps:

1. Select a hard disk on the Disk Map.
2. Call the Update MBR dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: **Hard Disk > Update MBR**.
   - Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, then select the menu item: **Update MBR**.
3. The operation will be performed immediately after confirmation.

**Task Scheduling**

Automation of operations can really help you out when you’ve got to accomplish certain routine operations on a regular basis as it enables to execute them without your involvement while optimizing your computer’s work-load.

**Setting a Timetable**

Thanks to the embedded Scheduler, you can set a timetable for execution of any operation. It has two categories for time settings (these correspond to appropriate items in the Schedule type menu):

- **Initiating the operation by an event:**
  - One time only (i.e. the Once item)
  - When the system starts (i.e. the At System Startup item)
  - When the user logs on (i.e. the At Logon item).
• Initiating the operation periodically (i.e. Daily, Weekly, Monthly).

You need to select one of the variants. Depending on your choice, the scheduler displays a form that enables to set a timetable.

To run the task in the log-off mode, please specify administering login info by following the appropriate link in the left lower corner of the page.

The Shutdown System on Complete option enables to automatically switch off the computer on the successful accomplishment of the operation.

Managing Tasks

All scheduled tasks are placed in a separate list, which can be retrieved by clicking the Scheduled Tasks tab in the Explorer Bar:

On every task you can get in-depth information, including:

• The task name
• The full path to the generated script of the task
• Scheduled time of launch
• Statistics on the last launch
To easily manage tasks, the program enables to arrange them according to a certain characteristic just by clicking on the required property.

This feature can be particularly beneficial when the Scheduled Tasks list contains too many items.

You can also enable/disable, rename, delete, refresh or modify properties of the selected task.

**Task Editor**

With the Task Editor you can easily modify properties of scheduled tasks. To do that, you should take the following steps:

1. Select a task on the Scheduled Tasks list.
2. Call the Task Editor dialog. There are several ways to do it:
   - Click the **Properties** button on the Scheduled Tasks list.
   - Call the popup menu for the selected task (right click of the mouse button), then select the menu item: **Properties**.
3. In the opened dialog window you can see two tabs - General and Schedule. Click the General tab to modify:
   - Full path to the macro-command program-interpreter, which describes the scheduled task;
   - Command line for starting the interpreter (i.e. the task described in macro-language)
   - Comments referring to the task
• The option of enabling/disabling the task.

By clicking the Schedule tab you can modify the task timetable.

In order to apply the changes, you need to click the Apply button at the foot of the dialog.

Creating a Scheduled Task

You can set a timetable for execution of any operation. For backup and copy operations the program offers handy wizards, while all the others can be scheduled with the Save to Scheduler dialog.

To create a scheduled task you should take the following steps:

1. Make sure the virtual mode of execution is enabled;
2. Carry out with the program all operations you need to schedule;
3. Call the Save to Scheduler dialog in the Main Menu: Tools > Save to Scheduler…;
4. In the opened dialog enter the required task name and specify the task timetable;
5. The operation will be performed immediately after confirmation.

⚠️ This command is unavailable if there are no operations on the List of Pending Operations.

Extra Functionality

This chapter describes the supplementary functionality available in the program.

View Partition/Hard Disk Properties
The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry, cluster size, exact partition location, etc.

There are several ways to get properties on a partition/hard disk:

1. Choose a partition/hard disk on the Disk Map, then select in the Main Menu: **Partition/Hard Disk > Properties...**;
2. Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk Map, then select the menu item: **Properties...**

![Properties dialog](image)

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get information you need.

**File Transfer Wizard**

File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning of them to CD/DVD as easy and convenient as possible. It may be of particular use in case of a system malfunction, caused either by a virus attack or files corruption, in order to get the system back on track again. Besides it provides access to Paragon backups as regular folders to browse through their contents or copy required files.

**Startup**

There are several ways to start the File Transfer Wizard:

- Select in the Main Menu: **Tools > File Transfer Wizard**.
- Select the **Transfer Files** item of the Wizards menu on the Common Tasks Bar.

**Setup**

Copyright © 1994-2012 Paragon Software GmbH. All rights reserved.
The wizard offers the following steps to accomplish the transfer operation:

- **Place to look for files/directories.** Select a source disk from the pull-down list in the left pane of the page. The program enables to process both mounted and unmounted (without drive letter assigned) partitions. Besides it is possible to map a network drive.

![Source Disk Selection](image)

- **Object(s) of operation.** Choose files/directories you want to copy and place them to Clipboard by pressing the Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane and press the Remove button. You can also create a new folder, rename or irreversibly delete existing files/directories of the left pane by pressing the appropriate buttons.

![Clipboard and Source](image)

> **Files/directories deleted from the Clipboard remain intact on source disks.**

- **Destination to store the object(s).** The File Transfer Wizard allows copying data to local or network drives, to physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose the way the data will be stored.

![Save Options](image)

- **Revision of changes.** The Transfer Summary page provides structurally divided information on all the actions made in the wizard. Check the changes and come back to any step of the wizard (if necessary) by following the required hyperlink.
Result

After the operation is completed the required data will be placed into the specified destination.

Available Operation Scenarios:

- **Copying of data from the corrupted system disk to another hard disk**
- **Burning of data from the corrupted system disk to CD/DVD**
- **Copying of data from a backup to the corrupted system partition**
- **Restoring separate files and folders from a backup**

Mount Partition

The program enables to assign or remove drive letters of existing formatted partitions.

**Assign Drive Letter**

In order to mount a partition you should take the following steps:

1. Select a partition on the Disk Map.
2. Select in the Main Menu: **Partition > Assign Drive Letter...**
3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this parameter. So you may just press the Yes button to confirm the operation.

![Assign a drive letter?](image)

However you can manually define the required letter by selecting it from the pull-down list of available drive letters.

4. The operation will be performed immediately after confirmation.

**Remove Drive Letter**

In order to un-mount a partition you should take the following steps:

1. Select a partition on the Disk Map.
2. Select in the Main Menu: **Partition > Remove Drive Letter.**
3. The operation will be performed immediately after confirmation.
Modifying drive letter of the system partition will result in inability to boot the operating system.

After having processed partitions with installed software, some programs may not run properly.

Mount Archive

The program provides the ability to assign a drive letter to a partition backup image. As a result of the operation you will get a new read-only partition in the system to easily browse through its contents and copy the required information even with the standard Windows tools.

Assign Drive Letter

In order to mount an archive you should take the following steps:

1. Select a backup image in the Archive Database.
2. Call the Mount Archive dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Archives > Mount the Selected Archive.
   - On the Explorer bar: select the Mount Archive item.
   - Call the popup menu for the selected image (right click of the mouse button), then select the menu item: Mount the Selected Archive...
3. Specify a drive letter for the selected backup image. Initially the program suggests some consistent value for this parameter. So you may just press the Yes button to confirm the operation.
   However you can manually define the required letter by selecting it from the pull-down list of available drive letters.
4. The operation will be performed immediately after confirmation.

The current version of the program allows the user to mount archives of separate partitions only.

There is no possibility to mount archives located on physical (unmounted) partitions.

Archives will only be mounted for the current session and won’t be available after the system restart.

It is strongly recommended not to un-mount backup images with Windows Disk Manager or other third side software.

Remove Drive Letter
In order to un-mount a backup image you should take the following steps:

1. Select a backup image in the Archive Database.
2. Call the Unmount Archive dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: **Archives > Unmount the Selected Archive**.
   - On the Explorer bar: select the **Unmount Archive** item.
   - Call the popup menu for the selected image (right click of the mouse button), then select the menu item: **Unmount the Selected Archive…**
3. The operation will be performed immediately after confirmation.

**Test Surface**

The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss.

In order to start the surface test you should take the following steps:

1. Select a partition or a block of free space on the Disk Map.
2. Call the Test Surface dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: **Partition > Test Surface…**
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: **Test Surface…**
3. From the pull-down list choose the level of the surface check.
4. The operation will be performed immediately after confirmation.

**Check File System Integrity**

The program allows you to check integrity of a file system. It can be used to detect possible file system errors before performing any operation on a partition.

To start the system integrity check you should take the following steps:

1. Select a partition on the Disk Map
2. Call the Check File System Integrity dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: **Partition > Check File System Integrity**
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: **Check File System Integrity**.
3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes button to confirm the operation.
• **Scan for and attempt to recover bad sectors.** Mark the checkbox to additionally process sectors marked bad in the file system metadata for the purpose of their possible recovery.

4. The operation will be performed immediately after confirmation.

**Check Archive Integrity**

The program provides the ability to check integrity of a backup image. The function allows distinguishing between valid and corrupted images before using them. The Check Archive Integrity Wizard will help you do that.

**Startup**

There are several ways to start the Check Archive Integrity Wizard:

- In the Main Menu: select **Wizards > Backup Utilities > Check Archive Integrity...**
- On the Common Tasks Bar: click the **Check Archive Integrity** item of the Wizards menu.
- Select a backup image in the Archive Database, then call the popup menu for it and choose the menu item: **Check Archive Integrity...**

**Setup**

The wizard offers the following steps to accomplish the operation:

- **An archive to verify.** The Browse for Archive page enables to find a backup image you need.

  By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive Database (if any).

  ![Archive Database List View](Image)

  To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.
By clicking the Switch to File View link, you can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also display a short description of the selected image.

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map network drives by clicking the appropriate buttons.

To know more on the subject, please consult the Viewing Image Properties chapter.

Result

After the operation is completed you can see results of the check.

Check Recovery Discs

You’ve got the ability to check whether backup media created with the program is 100 percent error-free and ready to use. The Check Recovery Disc Wizard will help you do that.

Startup

There are several ways to start the Check Recovery Disc Wizard:

- In the Main Menu: select Tools > Check Recovery Discs…
- On the Common Tasks Bar: click the Check Recovery Discs item of the Wizards menu.

Startup

The wizard offers the following steps to accomplish the operation:

- **CD/DVD drive.** Select from the pull-down list of available CD/DVD devices the required drive to use during the operation.

- Set whether to eject the disk after the operation is completed or not.
Result

After the operation is completed you can see results of the check.

View Logs

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all the information is structurally divided, besides there is the possibility to see the disk layout before and after an operation, what is very convenient.

In order to view logs on carried out operations call the View Logs dialog in the Main Menu: **Tools > View Logs...**

![Image of View Logs dialog]

**Typical Scenarios**

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can find here useful recommendations and descriptions of operations.

**Backup Scenarios**

**Creating the Backup Capsule**
Let us take a computer of a rank and file user who is most likely to have only one hard disk with only one partition (the only partition is always system). Suppose that there is enough free space on the hard disk to create the backup capsule as well. It can be created with the Manage Backup Capsule Wizard:

1. Click the Manage Backup Capsule item of the Wizards menu (any of the ways described earlier can also be used here).
2. On the Wizard's Welcome page, click the Next button.
3. Select a place on the disk where the backup capsule will be created. It can be created as a primary partition or as a logical drive within an extended partition. It can be inserted into any place on the hard disk: at the end (preferable), at the beginning or somewhere in the middle between other partitions.

By default, the program allows the user to create the backup capsule only as the last primary or as the last logical drive within the extended partition. However, by activating the advance mode on the first page of the wizard you can remove this restriction that in its turn might result in some boot problems.

4. Set the size for the backup capsule. It will be created at the expense of free space of the selected disk.

There is no restriction on the size of the backup capsule, merely depending on the available space of the hard disk and the capacity needed for the backup.

If the wizard cannot find enough free space in one block, it will redistribute free space, joining all free space blocks together into one united block and moving partitions if necessary. If the total amount of free space is still not enough, it is possible to split a fragment of space from one of the existing partitions, thus resizing it.

If the partition is locked and cannot be resized, the wizard makes the system reboot to create the backup capsule and automatically boots the system again. (The rebooting mechanism is different for different versions of Windows).

5. Start the operation (by clicking the Next button) or return to correct the settings.

After the operation is completed you can place backup archives into the created backup capsule.

**Backing up a hard disk or partition to the Backup Capsule**
To back up an entire hard disk or a separate partition and then place the resulted image into the backup capsule, please do the following:

1. **Create the backup capsule** with the Manage Backup Capsule Wizard.
2. Click the **Back up a Disk or Partition** item of the Wizards menu (any of the ways described earlier can also be used here).
3. On the Wizard's Welcome page, click the Next button.
4. On the What to back up page, mark the appropriate option opposite a hard disk's name or a partition’s name depending on the chosen task.

![Image of hard disk and partition selection]

You've got the option to modify the default backup settings by marking the appropriate checkbox on this page.

By default the program will take into account exclude filters set in the **Settings** dialog.

5. On the Backup Destination page, select the **Save data to the Backup Capsule** option.

![Image of backup destination options]

6. Edit the archive name if necessary.

![Image of archive name input]

Please take into account values of the parameters Estimated archive size and Space available on backup destination - if the archive size exceeds the available space, delete...
outdated backups from the Backup Capsule or resize it with the Manage Backup Capsule Wizard.

7. Add comments to your backup describing its contents.

8. Choose whether to accomplish the operation immediately, set a time table for it.

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

⚠️ This operation can also be accomplished with the Linux/DOS recovery environment.

### Backing up a hard disk or partition to external media (CD/DVD)

To back up an entire hard disk or a separate partition and then burn the resulted image to CD/DVD, please do the following:

1. Click the **Back up a Disk or Partition** item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard's Welcome page, click the Next button.

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on the chosen task.

   ![Backup Selection]

   The size of objects to back up: **499.3 GB**
   Estimated archive size: **72 GB**

   You’ve got the option to modify the default backup settings by marking the appropriate checkbox on this page.

   By default the program will take into account exclude filters set in the **Settings** dialog.

4. On the Backup Destination page, select the **Burn the data to CD or DVD** option.
5. Select a recordable device on the list of available CD/DVD devices and edit the archive name, if necessary.

6. Add comments to your backup describing its contents.

7. Choose whether to accomplish the operation immediately, or set a time table for it.

8. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

---

**Warning:**

Please take into account the Estimated archive size value. It can give you a hint about the number of CD/DVD discs required for the operation.

---

**Warning:**

This operation can also be accomplished with the Linux/DOS recovery environments.

---

**Back up a hard disk or partition to a network drive**

To back up an entire hard disk or a separate partition and then place the resulted image to a network share, please do the following:

1. Click the **Back up a Disk or Partition** item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard's Welcome page, click the Next button.
3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on the chosen task.

You've got the option to modify the default backup settings by marking the appropriate checkbox on this page.

By default the program will take into account exclude filters set in the Settings dialog.

4. On the Backup Destination page, select the Save data to local/network drives option.

5. Map a network disk to place your backup image to:
   - Call the Map Network Drive dialog by clicking the appropriate button;
   - Click the standard browse button [...] to browse for the required network share or manually enter a path to it;
   - Define a letter from the pull-down list of available drive letters;
- Mark the checkbox to make this connection permanent. Otherwise it will only be available for the current Windows session;
- Click the Connect as user button at the foot of the dialog page to specify a user name and password to access the selected network share if necessary.

6. Edit the archive name if necessary.

! Please take into account values of the parameters Estimated archive size and Space available on backup destination - if the archive size exceeds the available space, another network drive needs to be selected.

7. Add comments to your backup describing its contents.

! This operation can also be accomplished with the Linux/DOS recovery environments.

8. Choose whether to accomplish the operation immediately, set a time table for it.

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

Creating a differential to a full partition backup
To update an image of the selected partition, please do the following:

1. Click the Differential Partition Backup item of the Wizards menu.
2. On the Wizard's Welcome page, click the Next button.
3. On the Browse for Archive page, specify the required full (base) partition archive:
   - By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive Database (if any).
To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.

To know more on the subject, please consult the Viewing Image Properties chapter.

- By clicking the Switch to File View link, you can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also display a short description of the selected image.

To know more on the subject, please consult the Viewing Image Properties chapter.

4. The Archive Content page displays detailed information about the contents of the archive. It includes a full description of properties about the partition. In addition, there is the possibility to modify backup settings. To activate the advance mode, you need to mark the appropriate option at the foot of the page.
5. On the Backup Destination page, select where you want to place your backup image.

6. Edit the archive name if necessary.

![Archive Details](image)

Please take into account values of the parameters Estimated archive size and Space available on backup destination - if the archive size exceeds the available space, another drive needs to be selected.

7. Add comments to your backup describing its contents;

8. Choose whether to accomplish the operation immediately, set a time table for it.

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

After the operation is completed you receive a differential backup of the selected partition. It is placed into the specified destination (a local or network disk, the Backup Capsule or a CD/DVD disc), its features defined by the wizard.

**Recovery Scenarios**

Copyright © 1994-2012 Paragon Software GmbH. All rights reserved.
Restoring a system partition from external media (CD/DVD)

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical files. But you’ve got a backup of your system partition on a bootable DVD disc. That’s just enough to easily get your system back on track again.

To restore your system partition from a backup image located on CD/DVD when the current OS is down, please do the following:

1. Insert a CD/DVD disc containing the previously prepared backup image into a CD/DVD drive (the BIOS must be enabled to boot the system from the CD/DVD device).

   This scenario implies that you have got a bootable archive on your CD/DVD.
   In case the backup image is stored on several CD/DVD disks, please insert the first one.

2. Restart the computer.

3. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the **Low-Graphics Safe Mode** (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.

   ![Boot Menu]

   By default the Normal Mode will be automatically initiated after a 10 second idle period.

4. In the PTS DOS launch menu select the Simple Restore Wizard. You can find the same wizard in Linux as well.
5. On the Wizard's Welcome page, click the Next button.

6. On the What to Restore page, you can see a list of available images (if several). Most likely the required archive will be there too. If not, click the standard browse button [...] to find it. When you find your image, double click on it to proceed.

7. On the Image Properties page, make sure that you select the correct image by viewing the provided information about the archive.
8. On the next page specify a hard disk, then one of its partitions to restore the image to (if several in your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we actually need.

! All contents on the partition selected for restoring purposes will be deleted during the operation.

9. On the Partition Start and Size page you can change size of the partition and its location if necessary.

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next button to initiate the restore process.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
12. After completing the operation close the wizard, and then reboot the computer.

**Restoring a system partition from a local drive**

Let’s assume that your operating system gives trouble after having installed brand new software. But you’ve got a backup of the system partition on a local disk. That’s just enough to easily roll it back to the point when run smoothly.

To restore your system partition from a backup image located on a local disk, please do the following:

1. Click the **Restore** item of the Wizards menu (any of the ways described earlier can also be used here).
2. On the Restore Wizard's Welcome page, click the Next button.
3. On the Browse for Archive page, specify the required archive:
   - By clicking the **Switch to Archive List View** link, you can see a list of images contained in the Archive Database (if any).

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.

To know more on the subject, please consult the [Viewing Image Properties](#) chapter.
4. On the Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if several in your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we actually need.

5. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to change size of the partition and its location if necessary as well as assign a particular drive letter.

6. Complete the wizard and then apply the pending changes.

To know more on the subject, please consult the Viewing Image Properties chapter.

All contents on the partition selected for restoring purposes will be deleted during the operation.
7. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the appropriate button to agree.

8. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

After completing the operation the program will automatically reboot the computer.

Restoring a dual boot Mac from an external USB drive
Let's assume that your Mac fails to boot because of a hard disk malfunction. But you've got a backup of your hard disk on an external USB drive. Just replace the failed disk with a new one and carry out a bare metal restore.

To restore a dual boot Mac from a backup image located on an external USB drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   **Recovery Media Builder** can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. Connect an external USB drive to the computer.

3. Restart the computer.

4. In the boot menu select **Normal Mode** to use the Linux recovery environment, since it’s the only mode that enables to work with USB devices.

   ![Normal Mode](image)

   By default the Normal Mode will be automatically initiated after a 10 second idle period.

5. In the Linux launch menu select the Simple Restore Wizard.

6. On the Wizard's Welcome page, click the Next button.

7. On the What to Restore page, click the standard browse button [...] to find the required archive. When done, double click on it to select.
8. On the Image Properties page, make sure that you select the correct image by viewing the provided information about the archive.

9. On the next page specify a hard disk to restore the image to.

⚠️ All contents on disk selected for restoring purposes will be deleted during the operation.
10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next button to initiate the restore process.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

12. After completing the operation close the wizard, and then reboot the computer.

Copying of data from the corrupted system disk to another hard disk

To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to boot, please do the following:

1. Connect the second hard disk to the computer.
2. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

3. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode to use the PTS DOS recovery environment (in case you've got problems with Linux). Moreover you've got the option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.

By default the Normal Mode will be automatically initiated after a 10 second idle period.

4. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.

5. On the Wizard's Welcome page, click the Next button.

6. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.
Click the Calc button to estimate the resulted data size.

8. On the Select Destination Type, choose the way the data will be stored. Select the **Save data to any local drive or a network share** item.

   Please select how would you like to save the data:

   - **Save data to any local drives or a network share**
     
     Choose this option if you want to save your data to local mounted or physical partition, to USB or FireWire external drives and to a mounted network share. You will be prompted to choose a location you want to save the archive to.

   - **Burn data to CD/DVD**
     
     Choose this option if you want the Wizard to burn the data to CD or DVD. You will be prompted to choose a CD or DVD RW drive.

9. On the Select Destination Path page, select a hard disk to copy the data to by pressing the standard browse button [...].

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

**Burning of data from the corrupted system disk to CD/DVD**

To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   **Recovery Media Builder** can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the boot menu select **Normal Mode** to use the Linux recovery environment, since it’s the only mode that enables to burn CD/DVD discs.

   By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
4. On the Wizard's Welcome page, click the Next button.

5. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

6. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Click the Calc button to estimate the resulted data size.

7. On the Select Destination Type, choose the way the data will be stored. Select the **Burn data to CD/DVD** item.
8. On the Choose a Recorder page, select a recorder from the list of available devices and then set a volume label by entering it in the appropriate field.

9. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the operation.

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

11. After the operation is completed, close the wizard by pressing the appropriate button.

12. Turn off the computer.

**Copying of data from a backup to the corrupted system partition**

The system fails to boot since some files are damaged. If you have a backup of the system partition, you can recopy these files to make the system be operable again:

1. Start up the computer from our Linux/DOS recovery media.

---

*Recovery Media Builder* can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set...
2. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the **Low-Graphics Safe Mode** (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.

![Boot Menu](image)

**By default the Normal Mode will be automatically initiated after a 10 second idle period.**

3. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.

![Linux Launch Menu](image)

4. On the Wizard’s Welcome page, click the Next button.

5. Select a disk where the system backup is stored from the pull-down list in the right pane of the page.
6. Double click on the required backup to open.

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Click the Calc button to estimate the resulted data size.

8. On the Select Destination Type, choose the way the data will be stored. Select the **Save data to any local drive or a network share** item.
9. On the Select Destination Path page, select your system disk to copy the data to by pressing the standard browse button [...].

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

Restoring separate files and folders from a backup
The program provides a very convenient option to access backup archives and restore only data you need (the so called selective restore functionality). This operation can be accomplished either with the Restore Wizard, File Transfer Wizard or Volume Explorer.

**Restore Wizard**

To restore separate files and folders from a backup image with the Restore Wizard, please do the following:

1. Select the Restore Wizard.
2. On the Restore Wizard's Welcome page, click the Next button.
3. On the Browse for Archive page choose the required archive in the browser-like window. The Archive File Details section displays a short description of the selected image.

4. On the next page specify what you need to extract from the backup by marking checkboxes next to the required data items. At the right lower corner of the window you can see the resulted amount of the selected data.
5. On the How to Restore page specify the way the selected data will be restored. In our case we’d rather restore contents of the backup to its original location with replacing existing files as well.

6. On the Restore Summary page review all parameters of the operation and modify them if necessary.

7. On the next page of the wizard confirm the operation by selecting the appropriate option.

8. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

9. After completing the operation close the wizard, and then reboot the computer.

**File Transfer Wizard**

To restore separate files and folders from a backup image with the File Transfer Wizard, please do the following:

1. Call the popup menu for the required backup image (right click of the mouse button) in the Archive Database and then select the menu item: Restore File from Archive. Thus you automatically open it with the File Transfer Wizard.

2. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.
3. On the Select Destination Type, choose the way the data will be stored. Select the **Save data to any local drive or a network share** item.

4. On the Select Destination Path page, specify the exact place to copy the data to.

5. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the operation.

6. After the operation is completed, close the wizard by pressing the appropriate button.

**Saving Log Files**

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of having difficulties with handling the program, you, with the help of this very function, can address the company support
engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in order to tackle the encountered problem. Information of that kind is stored in log files.

To prepare a log files package, please do the following:

1. Select **Troubleshooting > Log Saver** in Express Launcher.

2. Provide an e-mail address used for registering the product, then give a detailed description on the encountered problem in the corresponding text fields. Please don’t worry - we respect your privacy, so none of your confidential data will be exposed. This utility only collects the program’s operation logs to help our Support Team find and tackle your problem. Click **Next** to continue.

   ![Log Saver Wizard](image)

   **Log files do not contain any confidential information on the operating system settings or the user documents.**

3. Browse for the required location of the log files package or manually provide a full path to it. Click **Save** to initiate the operation.
Troubleshooter

Here you can find answers to the most frequently asked questions that might arise while using the program.

1. I try to run an operation, but the program claims my partition is in use and suggests restarting the computer.
   There are a number of operations that cannot be performed while your partition is in use (or locked in other words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-up mode.

2. I run an operation and restart the machine as required, but it just boots back into Windows without accomplishing the operation.
   Please run `chkdsk /f` for the partition in question.

3. I cannot create a new partition on the disk.
   There can be a number of reasons for that:
   - The program cannot create a new partition on a dynamic disk, but only on a hard disk that uses the DOS partitioning scheme.
   - According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot be created:
     - Two Extended Partitions on one hard disk;
     - Five or more Primary partitions on one hard disk;
     - If there is an Extended Partition on the disk, only three Primary partitions are allowed.
   - The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free space on an existing partition to a new partition.

4. I cannot copy a partition.
   There can be a number of reasons for that:
   - The source or target disk you select is a dynamic disk;
4 primary partitions (or three primary partitions and an extended one) already exist on the target disk.

5. I need to copy a partition. But when selecting a place where to make a copy, I always get a crossed circle sign no matter which partition is selected.

The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free space on your hard disk, please delete or reduce an existing partition to accomplish the operation.

6. I cannot do anything with my USB flash drive. I get a crossed circle sign when trying to select any area on it.

Some USB flash drives don’t have the MBR (Master Boot Record), that’s the cause of your problem. To fix the issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc to write a standard code to your flash drive.

7. When trying to back up my system the program asks to restart the computer.

Most likely the Hot Processing mode is disabled. Please make it active in the program settings.

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could not be started for processed volume".

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot Processing mode instead.

9. I cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the following error: Hard Disk management, Error Code 0x1100a. What is wrong here?

The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to start it automatically).

10. When running a backup operation with the Paragon Hot Processing mode enabled, I get an error: error code 0x1200e "Internal error during Hot Backup"

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer’s tool.

You can find a name of the tool you need here: http://kb.paragon-software.com

11. When running a backup operation with the Microsoft VSS mode enabled, I get the following error: error code 0x12016 "VSS: can't read volume data"

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer’s tool.

You can find a name of the tool you need here: http://kb.paragon-software.com

12. When trying to back up to a network share, I get the following error: "i/o error" or "can't open/create file"

Please check whether you’ve got a permission to write to the selected destination or not.

13. When trying to restore a backup archive, I get the following error: "Can't restore to current selection" or "Archive does not fit"

Most likely you’re trying to restore a backup of the whole hard disk to a partition or vice versa.

14. I set up a timetable for a task, but it fails to execute.

There can be a number of reasons for that:

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call Notepad through scheduling);
- You don’t have permission to write to the selected backup destination.

**Glossary**

**Active Partition** is a partition from which an x86-based computer starts up. The active partition must be a primary partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap.

The term **backup** originates from the time when the best way to protect valuable information was to store it in form of archives on external media. It's become now a general notion to mean making duplications of data for protection purposes.

**Bootable Archive** is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will be able to restore the data from these archives without having to run the program, but by simply booting from these CD/DVDs.

**Cluster** is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of fragmentation on the volume. A cluster is also called an allocation unit.

**Extended Partition** is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is used if you want to create more than four volumes on a disk, since it may contain multiple logical drives.

**File System Metadata**. The servicing structures of a file system, which contain information about allocating files and directories, security information etc, are named the file system metadata. It is invisible for users and regular applications because its accidental modification usually makes a partition unusable.

**Hard Disk Geometry**. Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are divided into tracks (or heads), and tracks are divided into sectors.

The triad of values \([\text{Sectors-per-Track}], [\text{Tracks-per-Cylinder}], [\text{Amount-of-Cylinders}]\) is usually named the Hard Disk Geometry or C/H/S geometry.

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an essential role in the DOS Partitioning scheme.

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors are continuously enumerated from "0". To allow backward compatibility with older standards, modern hard disks can additionally emulate the C/H/S geometry.

**Hidden Partition**. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an operating system does not mount a hidden partition, thus preventing access to its contents.

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by XOR-ing the partition ID with a 0x10 hexadecimal value.

**Master File Table** (MFT) is a relational database that consists of rows of file records and columns of file attributes. It contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a FAT file system.

**MBR & 1st track of the hard disk** is the 0th sector of the disk. MBR (Master Boot Record) contains important information about the disk layout:
- The used partitioning scheme;
- The starting records of the Partition Table;
- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses).

Generally, the 0th sector is used for similar purposes in all existing partitioning schemes.

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed to use the entire 0th track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot Manager are located in the 0th track.

**Partition ID** (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions.

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space.

**Partition Label** (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition’s boot sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK utility.

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively large amount of text in multiple languages.

**Partitioning Scheme** is a set of rules, constraints and format of the on-disk structures to keep information on partitions located on a hard disk.

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible computers.

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 operating system.

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition, most hard disk utilities do not support it as well.

**Recovery Media** is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or recovery purposes.

**Root Directory** is the top-level directory of a formatted logical drive to include other files and directories. In modern file systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12 and FAT16 file systems.

**Serial Number.** In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility.

In fact, a hard disk’s serial number is not important for most operating systems and software. It is known that Windows NT, 2000 and XP store its value in the database of assigned drive letters.

A partition’s serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned when the partition is formatted. It does not play an important role for most operating systems and software as well.